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The Slides

Slides will be shared at the end of the prez’

You can also request a copy via email:

mholt@scoe.net



SLIDES

A QO N\ ~ Background Layout Theme

1 New! GIFs and stickers in Slides

Easily insert GIFs and stickers into your presentations by
going to Insert image > GIFs and stickers.

Got it




Slide Charts

Automagical Sheet
created and linked

Points scored

Team 1
21.8%
Team 4
34.5‘%»
T 3 Team 2
e 32.7%

10.9%




Slides Diagrams

Sooo many options and
all customizable! Vestibulum

congue

Choose different setups
colors, steps, and more

Vestibulum Vestibulum
congue congue

Lorem Ipsum Vestibulu
m congue

. .
Vestibulu Vestibulu
Lorem Ipsum
m congue m congue
Lorem Ipsum Lorem Ipsum

Vestibulu
m congue







bard.google.com

Need more info?

bard.google.com/faq

BARD

Introducing Bard Extensions

' CQ O

Get more done with apps - all in one place

Bard can now respond with real-time info from Google Maps, Flights,
Hotels, and YouTube, so you can get more done in one place.

Bard helps you automatically

To connect you with useful content, Bard may share parts of your
conversations and other relevant info, like your location, with other
services. These services may use that info for their improvement, even
if you later delete your Bard activity. You can turn extensions off
anytime on the Extensions page.

Learn more in the Bard Privacy Help Hub



https://bard.google.com/faq

Docs - Pageless

N
Save paper - don’t print.
Save space - go pageless!

Remove page breaks and
borders using Pageless option
within Page Setup.

(File / Page setup)

y ]
Page setup
Pages Pageless

Bottom 0.5
Letter (8.5"x11") ~

Page color Left 0.5

Page setup

ageless




Docs - Dropdown list

Add dropdowns for project
Stqtus’ qsset IiSts’ CheCk_OUtS’ The teacher used Google Slides - to present to the class.
fi”_in exerCisesl qnd more! Fortheequation2+3,thec|nsweris

The student wants to learn the basics - of using a computer.

-+ Add/Edit Options

EQUIPMENT CHECKOUT
Student Name Date item Due date
Winky Whotoo 2/21/23  Tablet - 6/1/23
Ninjee Techee 3/27/23  Laptop - 4/5/23
Select ~
Select - |




Copy [ Paste AND Remove Format

After copying text from a website, PDF, or other platform,
the formatting comes with it.

Remove formatting in one step. CTRL+shift+v

Note: this will remove links as well!

esc — —= C OO & & % “ O

@ # $ % ! &
2 3 7

4 5 6 backspace
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Chrome Share Button - Changes coming

The Chrome share button is located
within the address bar and allows
sharing a url to your other devices,
casting, and creating a QR code.

Some users have “lost” their button!

It has moved to the page that is being
viewed.

Right click on the page and all the same
sharing options will appear.

The share button has less options
than right clicking on a page - start
right clicking!

Back

Reload

Save As...

Print...

Cast...

Search Images with Google

Send to Your Devices
Create QR Code for this Page

Translate to English

] Copy link

[0 Send to your devices

(23} Create QR Code

3] Cast...

[¥] Save page as...




Sheet Chips

n ]
Insert Smart Chips to add
collaborators, calendar
events, rating scales and
more
SMART SHEETCHIPS  # & & | D B -
File Edit View Insert Format Data Tools Extensions Help
QA 6 2@ 3§ 1006~ $ % O 9 23 Defaul. ~ - [8B]+ B I = A > H Ev i biv A~
E15 *
+ Rating People Calendar Events Place Finance
0 Sherman's Deli
Class 1 , Melinda Holt % HOLIDAY & Bakery % .DJI
s Class 2
Add collaborators Calendar info from Location is Finance gives
Class 3 with the "@" your calendar clickable map link up-to-date info
¢ SMART CHIPS are in the Insert menu OR start with @ in a cell




REQUESTS

. Dlifferent color browsers per account

. Google Certification

. Transition to Google Clsssrom - uploading
assignment



New Stuff!

(relatively)




Chrome Privacy

Turn cookies on and off as
heeded.

After clearing history the
settings may default back
- just change them

chrome://settings/privacy

(O
Enhanced ad privacy in Chrome

We're launching new privacy features that give you more choice over the
ads you see.

Chrome notes topics of interest based on your recent browsing history.
Also, sites you visit can determine what you like. Later, sites can ask for
this information to show you personalized ads. You can choose which
topics and sites are used to show you ads.

&= p
® X
J X

To measure the performance of an ad, limited types of data are shared
between sites, such as the time of day an ad was shown to you.

More about ads in Chrome v

You can make changes in Chrome settings




Chrome Settings

Search for any setting or word in the search and
look for the yellow highlights.

c @ »©» % P & m )

®

|4

Settings

You and Google
Autofill and passwords
Privacy and security
Performance
Appearance

Search engine

Default browser

On startup

Languages
Downloads

Accessibility

Q, caption
Font size Medium (Recommended)
Customize fonts
10 results
Lo, 100%

Pressing Tab on a webpage highlights links, as well as form fields

Show warning before quitting with §Q

Accessibility

Live Caption
Automatically creates captions for English audio and video. Audio and captions never leave your
device.

Caption preferences
Customize caption size and style for Live Caption. Some apps and sites will also use this setting.



Drive Filter

Find files easier!

Some of the advanced find filters have been moved to
the Drive deck.

Filters can be toggled on and off by selecting the Filter
switch at the top, far right of the Drive list.

Find specific file types, people who own or are included
on a share, and the ability to date-range the Last
modified date.

My Drive ~ =
| File type ~ People ~ Last modified ~

Name M Owner Last modified File size



Docs - Styles

L F |
Chqnge StYIGS to View Insert Format Tools Extensions Help
automagically format your _ . 4
document. Normal text

Normal and Header styles can | ©©©O¢- Title - RCES

be set to any font face, size, or Sublitle

color. i
Google Arts an Headi ng 1

resource!

Once applied all similar styles

) Heading 2
will reflect any changes.

Heading 3

Using styles ensures
accessibility too. Heading 4

Options




Drive Gear

Turn on/off:

e Suggestions
e Upload conversion
e Offline access

<& Settings

General
Notifications

Manage apps

Storage

1.4 GB of 17 GB used

[ Buy storage { viewitems taking up storage

Density

@ Comfortable

O Cozy

O Compact

Uploads

Convert uploads to Google Docs editor format

Offline

Create, open and edit your recent Google Docs, Sheets, and Slides files on this device while offline

Not recommended on public or shared computers. Learn more

Suggested files

Show suggested files in My Drive and shared drives




Drive - Find and Organize

Quick tools are inline with a file or folder name.

To the right of a file's size, select Share, Download, Rename,
Add to starred list, or select the Skinny Snowman (More
Tools)for the same tools and more!

My Drive ~

| Filetype -~ People ~ Last modified ~ = @\ O

Name M Owner Last modified File size

Bl Coding with Slides B me Mar 18, 2023 me 1KB O Vv 4 3% :

«cHO NBEED+ O R &
>
&

[

o
]
3
Q



Drive - Spam

Not all files shared with us should be
opened.

Vendors and other business may share
a file with you that you really do not
need (or want.)

Spammers and hackers share files too -
and they should never be opened!

Drag files to the Spam folder under the
New button and mark the file as Spam,
Inappropriate, a Copyright violation,
Child endangerment, or Other.

You can also Block file owners.

L Drive
+ New

My Drive

Shared drives

v

O
» [0 Computers

2 Shared w

O
(O Recent

O
Y% Starred
©® Spam
] Trash

What are you reporting?

Spam or fraud
E.g. Unwanted solicitation, phishing, malware, or impersonation

Disturbing or inappropriate content

E.g. Violence, hate speech, terrorism, harassment, bullying, threats,
intimidation, or sexually explicit material

O Copyright violation

E.g. Sharing copyrighted content without authorization

Child endangerment

E.g. Exploiting minors or people who appear to be minors

Other illegal activity

E.g. Promoting or selling illegal activities, goods, services or information

Block file owners

This account won’t be able to interact with you in Google Drive and certain
other Google products

Learn more Cancel



Pageless - Pin Table Header

Pin table headers when using
pageless format on Google

Docs.

As table data scrolls by, the e
header stays at the top of the S
pa g e a 8 ;;J%B South $05790 §138 .556
Segway

This is cool but use Sheets!

Insert the Sheet into the Doc.
The Doc updates with the
Sheet.



Pick Custom Color Tool

Within the Fill or border
color tools (paint bucket or
line color), use the
Eyedropper to select a
color on the screen OR on
a desktop.

Available wherever color
options are given.

O 7

Solid Gradient

SIMPLE LIGHT

CUSTOM

000 000
000 ©




My Maps -formerly Maps Engine

Create maps for students, schools,conferences, et

Lessons can be created for math, history, and
literature.

https://www.google.com/maps/d/u/0/

Google My Maps

+ CREATE A NEW MAP ALL OWNED NOT OWNED SHARED RECENT

B TR M T
l A}
s
v
- .
gitech Presentation
US Civil War Untitled map CALIFORNIA TDLS 2015 - Eateries
Oct 24,2023 & Jun 15,2023 @ Apr15,2022 @ Oct2,2020 &

i o STR B e e SERe

ad

; .
"
S s
I
~ +

Copy of State borders States USA National Parks, Nation... US Civil War
Jul2,2019 @ Jul2,2019 @ Jul1,2019 ® Jul1,2019 ®



https://www.google.com/maps/d/u/0/
https://www.google.com/maps/d/u/0/

Customize Google Forms

Google Forms has added the ability
to customize the header,
sub-header, and body text
separately throughout the form.

Select the themes button and add a
header image, change colors, apply
different fonts and sizes for
accessibility.

o o o K

> Theme
Text style
Header

Question

Text

Header

Image uploaded X

Color

YYYY
-
0 +

Background v

Roboto v 24 ~

Roboto v 12 v

Roboto v 11 ~




Toggle Format tool

TO TURN ON

e Select text that is formatted the way
you want multiple others to be

formatted the same way

e Double-click the Paint format tool - it
stays on.

e Select text in Docs, cells in Sheets, or
elements in slides and the format will

be applied.
TO TURN OFF

Select the Paint format tool.



View Fonts and Icons

45 Google Fonts

Designed primarily for use
online, there are thousands

of Google Fonts available to Stood The Google o

all to view and use.

view including different

Sofia Sans Condensed
Lettersoup, Botio Nikoltchev, Ani Petr

S i Z e S G n d S ty I e S o There in the distan.(‘:e stoo; The

Google for all to view and use.

Symbols are also available
in three styles and four
adjustable variable font
styles (fill, weight, grade,
and optical size).

Downloads are available - read the

online article “"How To Download and
Install Google Fonts.”

Category v Q_ Search Material Symbols

There in the distance
stood The Google for all to
view and use.

Hanken Grotesk
Alfredo Marco Pradil, Hanker

There in the distance
stood The Google for
all to view and use.

There in the distance stood The Google
for all to view and use.

Alexandria
Mohamed Gabe

There in the distance
stood The Google for
all to view and use.

Customization

Fil @

Weight

—_—

100
Grade

—
-25 (low) 200 (high emphasis)
Optical Size @

S —-Y

20px 48px

Fill: 0 Weight: 400 Grade: O Optical Size: 48



https://www.alphr.com/download-install-google-fonts/
https://www.alphr.com/download-install-google-fonts/

Docs - View Non-print Characters

I

View non-printing characters in a View-non-printing-characters-4
document including: q

e Paragraph/Hard break :_Uka'docume”t“

. ike <
e Line/Soft break ¢
e Section break IS Y S P S ——
® Paragraph/Hard e Page-break 4

e Page break break-® e Column-break:9

e Column break e Line/Soft-break-¢ e Tab¢

e Tab e Section-break- e Spacef
Select the View menu and then
"ShOW non_printing ChqquterS" to View Insert Format Tools Extensions Help
turn on and off. /' Mode
OI‘ v/ Show print layout

v Show ruler
Use the quick_key Combo v/ Show outline Ctrl+Alt+A Ctrl+Alt+H
CTRL+Shift+P as an on and off SUESIESISRESe
. v/ Show non-printing characters Ctrl+Shift+P

switch.

r"
L 4 Full screen



Docs: Orientation PER PAGE in Same Doc

Have a table, chart, image, or
something else that will not fit on
a Google Doc?

Select content and apply a
landscape page orientation to it

badabing, badaboom!

The content that was selected
prints as landscape and rest of
the document remains in Portrait
orientation.

Format

1. Left-to-right text

1 Right-to-left text

B Text

= Paragraph styles

r= Align & indent

1= Line & paragraph spacing

== Columns

:= Bullets & numbering

= Headers & footers
# Page numbers

Page orientation

Page orientation X

Apply to
Selected content

Orientation

(O Portrait ® Landscape




Google Earth - Lessons and More

earth.google.com

e Use Voyager for
lessons

e Create Projects for
classes

<= Voyager

e Measure Distance

Additional account
settings are available
(save project) as well.



http://earth.google.com

TRENDS

Trends
Analyze popular Google searches across regions and
languages in real time.

Google 2022 trends
See what others searched for in a specific area during 2022

Google Frietgeist
Halloween costume trends per region or search

Google Trends Lessons
A beginner’s course that teaches the basics of Trends using
Google’s free Trends tool.

Of the 3 places in the U.S. that
had | ; as their top trending

“near me” search, the Atlanta,
GA area searched for it the most



https://trends.google.com/home
https://trends.google.com/trends/yis/2022/US/
https://frightgeist.withgoogle.com/
https://newsinitiative.withgoogle.com/resources/lessons/basics-of-google-trends/

Arts and Culture - Teacher Guides

Art

Connect lessons with Art, History,
and more using Google Arts and N
Culture.

Community and
Cultural Identity

Lesson Plan

https://artsandculture.
google.com/project/
lesson-plans

Natural history

Past, present and future?

|
|
lan 20 ﬁ

s pren

e 20 i
Explore the Botanic World of
Gardens



https://artsandculture.
https://artsandculture.
https://artsandculture.

Chromebooks Can Record

Press Shift + Ctrl + Show
windows.

esc [~ (= C Ol (& (% €€ O

DEEEEE00EEENE

a s d‘ngHh j k | " | enter

In the menu at the bottom, select o B
Screen record. wa | e e

Select to Record the full screen or
Record a partial screen.

OR

Use the launcher to open the
Screencast tool.

Watch 2 minute video on how it
works

(must use ChromeOS
to view)


https://www.youtube.com/watch?v=7mp1TcpJfF4&t=51s
https://www.youtube.com/watch?v=7mp1TcpJfF4&t=51s

Add Fonts

Select the font name (usually
Arial) then “More Fonts.”

Search by nhame, script type,
and popularity.

Select the font on the left to add
to a Google account.

Fonts already added to o
Google account appear under
My Fonts and can be deleted
from there.

Once added in one Google app
- they are available in every
other.

Fonts

Roboto

Montserrat

Lato

Roboto Condensed

Source Sans Pro

Roboto Mono

DDDDDDD
nnnnnnnnnnn
ooooooooo
Serif

Sans Serif

Arial Black

Arial Rounded

Avenir

CCCCCC

nnnnnnnn

Poppins

Shanti

nnnnnnnnn




Docs - Find Similar Format

2.
3.
4.

Right-click
Select Format options, then
“Select all matching text”

Place cursor within text that is specific color, size,

Especially good for finding the bold, color text that

should be a heading,.

Using Docs

a cell is (2 Ppaste without formatting

Suggest edits

@® Insert emoji reaction

Beet 1 o insertiink

ChiCOry, [ Define 'Password'

Iungo q Tt Format options

X Clear formatting

VL MU AWV ATy M YY

I I[psum is not simply

-atin literaty of from 45

shirev  f @ living ipsum per the

comingus curtailed

Pt 3n to thwart foot fungi

ar sea lettuce kohlrabi

* chestnut ricev beans

19

Select all matching text

Update ‘Normal text' to match

van2ty filterages for fiftyish



Chrome Share

1.g212b4c604f0_1_5

Share pages or sites to your other
. Send to your devices
d eVI Ces. Choose a device. Then, to see the page, open Chrome

there.

SCOEs-MacBook-Pro
Active today

If you use several devices, you can use
the share tool in Chrome to send a site N
address to those devices.

Select the Share option and then
choose the device to send the link.
When you sign into that device, you'll
get a message that the link is
available.



Chrome QR Code

Need a QR now?

The Chrome QR code creator can be alas i

used on any page or file! soen e

Not enamored with Dino?

e Copy the QR (screengrab, snippet,
image grab)

e Paste into Google Draw

e layer a white box over the little guy
without touching any of the little
squares.

e Add another graphic or text in the
middle if needed.

e Download as a PNG or JPG and share
as needed




Drive Priority and Workspace (Club)

Turn on special areas to get to the
info you need asap.

Workspace works like shortcut
folder = all the info related to a
project can be added. When the
projec is “fin"” then delete the
workspace - the files remain in the
original locations.



Docs: Word Count

Located in Tools menu of Docs, Word count
the Word count can be turned Pages 53
on to display while typing Words 6539

Characters 41110

Select specific sentences,
paragraphs, or sections to view
exact counts for those areas.

Characters excluding spaces 34442

D Display word count while typing

This is a great example of a strong password. It's strong, long, and difficult for
someone else to guess. It uses more than 10 characters with letters (both
uppercase and Iowercose), numbers, and symbols, and includes no obvious

1 page out of 53 or common words. This password might even be a bit
69 words out of 6939 :member without a password manager, which
430 characters out of 41110 y're so helpful when creating a strong password.

362 characters out of 34442 (excluding spaces)

Hideward cour 1se tips whenever you create a password to keep your

= unnunnonon sufe and sectire



Docs: Explore Citations

Segway - Explore tool has moved into Tools permanently within Google apps.
Segway too - Citations can be used within Explore too.

Citations and footnotes can be added to any Doc. Cites allowed as book
section, website, journal or news article, film, TV series or episod and
“micellaminous” (other).

Add citations and a bibliography as:

e MLA (8thed.)
e APA (7thed.)
e Chicago Author-Date (17th ed.)

'"Free Internet Safety Tutorial at GCFGlobal.” https://edu.gcfglobal.org/en/internetsafety/. Accessed 31 Mar.

2023.
2"Free Internet Tutorials at GCFGlobal." https://edu.gcfalobal.ora/en/topics/internet/. Accessed 31 Mar. 2023.

Creating strong passwords’



Google Bard

Google’s answer to ChatGPT is
Google Bard.

“... slow to release for safety
concerns ... .

Artificial Intelligence is being
used for search AND a chat.

Google’s Bard is in beta where

eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee

Bard may display inaccurate or offensive information that doesn't represent Google’s views.

users are asked questions to
improve and filter inappropriate
content.



https://bard.google.com/

ApSki: Math Collection

Math lessons have been
added to Applied Digital
Skills Collections.

Just a few to start but 4 is
better than “x".

Access the Applied Digital
Skills collections then scroll
to find Math.

Applied Digital Skills

Lesson Collections @

Back to School 2022

These lessons help students express

themselves, get organized, and more

Digital Learning Day

Learn new digital skils to celebrate Digital

Learning Day

Learn at the Library

Build diaital skills to arow vour orofessional

Capstone Project

Lessons that help students organize, plan, and

execute a community service project

Personal Projects

Increase your personal productivity and do

creative tasks

College Readiness

Learn skills to olan for collece and other

Start or Grow Your Small Business

D

business skills and get started as an

Math

Learn digital skills while exploring math
concepts

Collection of 4 lessons



https://applieddigitalskills.withgoogle.com/c/en/collections
https://applieddigitalskills.withgoogle.com/c/en/collections

);



Tools and more by
Topic




CONTENTS

e Google Versions

e CHROME
o CALENDAR
o CLUB NEWS
e DRIVE APPS
e ODDS & ENDS




Google Versions

GOOGLE EDU has 4 flavors:

e Google Workspace for
Education Fundamentals

e Education Standard ($)

e Teaching and Learning Upgrade

($)

e Education Plus ($$)

See and compare versions

Education Education Teaching Education
Fundamental Standard d Pl
Learning
Upgrade
Gmail and Calendar v v v v
Groups for Business v 4 v v
Chat and chat rooms v v v v
Digital whiteboarding with Jamboard v v v v
Storage and collaboration: Drive, Docs v v v v
editors
Sites v v v v
Tasks v v v v
Notetaking with Keep v v v v
Video conferencing with Meet v v v v
Directory management v v v v
Additional Google services 4 4 v v
Google Vault for eDiscovery and v v v v
information governance
Google Cloud Search for internal search v*
and assist (across Google and third-
party services)
Integrate third-party repositories in v*
Cloud Search &
Index third-party data using Cloud v*
Search
AppSheet Core v

And two types:

CLUB - managed by district.
There may be restrictions - ask
to receive!

PUB - managed by Google.
No harm, no foul, no problem!



https://support.google.com/a/answer/10077155

CHROME
1 3

PIN TAB e+ T |cD %mm‘mmx Y -

- & G Search Google or type a URL

‘ o
GROUP TABS 24256,

L
Gmail Images i %

NAME WINDOW

EXTENSION MGR.

READ LIST

P R O FI LE S Q  Search Google or type a URL s

CUSTOMIZE COLOR 2 (o} e + G

SHORTCUTS & CARDS

o0 N ;o R W N

RIGHT CLICK!

ll
=

UPDATE

Select a bulleted item to open a specific Chrome Enhancement.

Use Return, in the lower right corner, to return to the menu.
MAIN
TOC



#

CHROME: Pin Tabs

Save space and work! Pins will remain after Chrome is closed IF account is not
signed out.

€ Inbox (3) - scoetech@gmail.cc X 2022 COABE National Virtual ¢ X +

@ coabenationalvirtualconf.pathable.co/?openNativeApp=true

l‘dl“

% MelindaHolt v
COABE

Home Schedule v People v Exhibitors v Gamification v Conference Maps v Resources Vv Register H

Communications v Help

Pins appear above the
Reload

MAIN
TOC




CHROME: Name Windows

Denote by task or projects to quickly
find and organize.

Window Help

Minimize

Zoom

Tile Window to Left of Screen
Tile Window to Right of Screen
Replace Tiled Window

Show As Tab

0
| — Name Window...
Google r I CAS R NS

N . e T ]

GooAdmin
¢ : GooTech

' S ' Student1
° - $
5 . Student 2

Trainer
v WORK




CHROME 4: Extensions

Open Extensions to:

e See adll extensions and

permissions
e PIN extensions for quick access
. . Extensions ;
e Hide extensions - to save space.
Full access

These extensions can see and change

e Remove extensions

information on this site.

[ MG nage EXtenSionS (@ Awesome Screenshot and...

\ ColorPick Eyedropper i

Access requested
To give an extension access to this site, click it.

ra

4+ Chrome Capture - Gif & Sc... 1

=)

=P Link to Text Fragment

2=

[8] QR Code Generator

No access needed
These extensions don't need to see and

change information on this site.

(' Grackle Accessibility Chec |

MAIN & Manage Extensions
TOC




CHROME: Reading List

Add articles, videos, searches for
later reading and then remove.

Bookmarks also included (beyond
bookmark bar.

Reading List Bookmarks X

+ Add current tab

UNREAD

Does Software that Explains Itself Really ...
learningenglish.voanews.com - 2 secs ago

bonanza lyrics - Google Search o @
google.com - 1 min ago

PAGES YOU'VE READ

Workspace Essentials | Google Cloud Skil...
cloudskillsboost.google - 38 days ago



CHROME: Using Profiles

Chrome allows a user to sync
account information AND switch
between profiles.

This allows users to use multiple
accounts at one time (professional,
personal, project specific, etc.

TIPS
e Sync’ when prompted!

e Use different Chrome color
scheme for different accounts.

e Know the difference between
the Chrome and the Google
account avatars

e Ask yourself: Who am I? Which
account should | use (where
you are located)?

Melinda Holt

mholt@scoe.net

o B @
® syncison

G Manage your Google Account

Other Profiles

4" Me (MeHoMm)

% Melinda (MeHoAdmin)
Ring A. (RingADing)

©© Ringa D. (RingADotDing)
% SCOE (GOOTech)

&8 SCOE (MeHo1)

&9 Tikki

m Winky (WinkyWhoToo)

e Guest

4+ Add




CHROME: Customize (colorize!)

Chrome can be customized with
different backgrounds, colors, and

themes.
Use different color schemes to denote

ifi 1 i P
specific profiles in use.

o

Example: B e
Work account = Orange L e ]
Personal = Blue :Z::\:uxs i "N Google |5 “»q’
Use different colors so you know who g 1
you are! | » e d prrm—
Whoooo are you? Who Who? Who Who? il

MAIN
TOC




CHROME: Shortcuts and Cards

—
Shortcuts and cards appear on a new e
o AR

Chrome tab.
Shortcuts are like bookmarks and can s ©@ © @
be added to any site or online file. i

[» ] > +
Cards are based on searches by the
profile and change per profile.

CARDS

Use of cards may be managed by the Google CLUB (district).

Shortcuts and Cards can be toggled on and off as needed per profile.

Customize this page

Customize this pag
3 Background 0 o
Background O  Hideall cards
GD  Shortcuts
Shi ® i 3
T o0 000
&= Cards
IO O ] & Cards
eeeeeeeeeee 9
@ Color and theme
@ Color and them
My shortcuts Most visited sites iical @
Shortcuts are curated by you Shortcuts are suggestex d based on websites
it often et disc
® Hide shortcuts

Don't show shortcuts on this page




CHROME: Right Click

Right click on a page or select text
and then right click.

Magical terms appear!
Bada-bing bada boom!

Copy link to Selected Text

Look Up “Our Mission”

Copy

Copy Link to Highlight

Search Google for “Our Mission”
Print...

L} Chrome Capture - Gif Screenshot tool
= Copy Link to Selected Text
EE Generate QR Code

5 Pronounce "Our Mission"
Inspect

Speech
Services

>


https://coabe.org/covid-19-resources/#:~:text=Webinar%20%26%20Download%20Resources-,easy%20microsoft%20word,-%2C%20Excel%2C%20and%20PowerPoint

CHROME: Update!

Always check for updates to get the
latest greatest features and
functions!

& © & NewTab x W

<« > C G Search Google or type a URL

¢ OTAN

Q_  Search Google or type a URL

MAIN
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o |

Classroom

o

RemoveBG

O

Contacts

@

TimeZones

123Apps

+

Add shortcut

(=

v

h % » 0O :

Gmail Images  ::% %

/" Customize Chrome



CALENDAR

USE MORE THAN ONE
KEYBOARD SHORTCUTS

TASKS and ADD-ONS

= [} Calendar > April 2022

I— Create ~

April 2022 10 A8 (12) 13

COABE

® 11am CIP Office ® 1:30pm COABE:

S M T
27 28 29 ® 11:45am COABI

3 4 5 ® 5:15pm HyFlex

10 n a 18

17 18 19

24 25 26




CALENDAR 1: Use more than one!

[ 4
P U B = E Calendar Today < > March2022 Q @ @ Mot ¥ HH 6
SUN Mon TuE saT

Create and share an additional —
calendar on the same account. Allow ‘;5 ° - E
others to see those but never your SR
personal calendar

&, search for peop
c L U B Time Insights
MAR 1 - 31, 2022
etings

aaaaaaaaaaa

Events recognized as meetings will
offer to create meeting notes (a Doc in 0 e '

[J scoeTech
[ Tasks

.
D r Ive) ° Other calendars + A

Viewers only see what you allow.



https://calendar.google.com/calendar/embed?src=otantrainsu%40gmail.com&ctz=America%2FLos_Angeles

CALENDAR 2: Keyboard Shortcuts T0C

Also in settings (and available to all).

Turn on keyboard shortcuts to quickly do tasks

within calendar. Keyboard shortcuts

Use the question mark (SHIFT ?) to see the list Enablekeyboard shortouts

of shortcuts available. Keyboard shortcuts
Navigation Views
Try using M, D, or Y! b o Kk Previous period 1o d Dayview
n or j Next period 2 or w  Week view
t  Today 3 or m  Month view
g  Gotodate 4 or x  Custom view
5 or a Schedule view
6 or y  Yearview

© Create event

Edit event

Backspace or Delete Delete event




CALENDAR 3: Tasks and Add-Ons

Add tasks and check them off as

completed. @

e Use the calendar side panel to

open and create tasks. —
e Set tasks with due dates and My Tasks ~ X
times
e View completed tasks. & Add a task
() Q3 Report
Fri, Apr 22, 12:00 PM
O
Completed (1) v

v/ Calendartvents
Add presentations to calendar for
staff




CLUB NEW'’S

1. Location settings

2. GMail: Active and Away

3. GMail New View




CLUB 1: Location Settings

Within Calendar, available only with
district (school) accounts (the
club!).

Add work location and times. They
appear on the calendar and wiill

Only your administrator can set your main office location

. Enable working hours
Working hours will inform people if they try to invite you to a meeting outside of these hours

Enable working location

Lets others know where you're working when they invite you to an event.
Only people who can view your free/busy availability can see your working location.

0 00 :

Eg Office v
M Home v
© Starbucks v

u : :
help others know “where you are Monday 700am  to  400pm
|OCCIted." 6:00pm to  7:30pm

Wednesday 7:00am to  4:00pm
Friday 7:00am to  4:00pm
6:00pm to  7:30pm
10 1 @ 13 14 15 16
© Hom, © starbucks
17 18 19 20 21 22 23
Office 0 Hom: 0 Starbucks
24 25 26 27 28 29 30
Office @ Hom: © starbucks

TOPIC
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-
CLUB 2: Active/Away Toc

Active and Away

Set your status for co-workers.

o , - ® Active ¥ @ @
This is only available within the
CLUB.




CLUB 3: A different view

PUB’' and CLUB both have Quick
Settings (Gear).

New Gmail View is only available for
Club accounts

M Gmail

N

Compose

Inbox
Starred
Snoozed
Sent

Drafts

< DV e *O

More

LABELS

Quick settings

See all settings

Manage this organization

You're using the
original Gmail view

Try out the new
Gmail view

]




DRIVE APPS

DOCS

1. SMART CHIPS
2. CHECKLIST & WATERMARK

SLIDES

1. HIDE FILMSTRIP
2. COPY

SHEETS

1. DATASET COPY



https://bit.ly/SheetsDataSets

DOCS 1: Smart Chips

Get or add information on people, files, and events
to Google Docs by using @ symbol.

DOCUMENT

e Type @ anywhere and scroll thru menu items
or

o Type @today for today’s date (or @yesterday,
@tomorrow, @June 22)

e Book a meeting directly,

e Add files using smart chips - Google will
prompt to share and, if file name changes so
does the chip

@

BUILDING BLOCKS

@ Meeting notes

2 Email draft

FILES

B COABE 2022 Submission
CONF22-GooSlam

LISTS

¥~ Checklist

— Numbered list

Bulleted list

MEDIA

Q Image
@ Table

M nrawiina

TOPIC
TOC
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DOCS 2: Checklist

—
Add a Checklist to a Doc using the tool
next to a bulleted list. As items are
checked they appear as strikethrough Sehedule-meeting
(completed.) [J Create agenda

. . . [J Share agenda for input
Read this article and options on

Checklists explained at “How to Geek”

Add a Watermark using the Insert

menu.
Add a watermark through tfhe Insert menu.
1 Once it is added, you can Type directly over a Watermark.
Once I n Serted’ teXt Cq n be typed OVG r Text may default to include a highlight.
th e I m q g e- Highlights may make the text easier to read but can be made transparent using

highlighter tool.

A watermark has settings of its own that
will appear in a panel to the right.

MAIN
TOC



https://www.howtogeek.com/733363/how-to-create-a-checklist-in-google-docs/

SLIDES 1: Hide Filmstrip

e — —
Hide the left panel (filmstrip) to 26 (names
save space or when presenting T
without using Slideshow. e
o0
Cl




TOPIC
SLIDES 2: Force Copy

Send a link to students or colleagues that makes a copy of the file for them
automagically after the link is selected.

Get link

Anyone on the internet with this link can view

Select the Share button e Copy lnk
Copy the shareable link

Replace “edit?usp=sharing” (the end of the link) with “copy”

Send that link to others

P WD -

https://docs.google.com/presentation/d/lcmpmHwkHgnzZk5e _HYMufhYRI-
FUfk-8CrnHsro9XI21Q/copy

Google Slides

Copy document

Would you like to make a copy of CONF22-GooSlam?

TIP:

Create the link then use a URL shortener - the link is easier to read AND to
verbalize!

MAIN
TOC




ODDS and ENDS

o ACCOUNT CREATION
o ACCOUNT SECURITY

e APPLIED DIGITAL SKILLS

e ARTS and CULTURE (coloring book and labs!)
e CLASSROOM

e DRAW
o OFFLINE ACCESS
e SEARCH

e SHARE with YOURSELF



#

ACCOUNT CREATION

YES, you need a Google Account to use Drive and
save photo's etc.

Google

Create your Google Account

NO, you do not need a GMail address!

Google Accounts can be created with YAHOO,

testyGoo@yahoo.com

HOTMAIL, VERIZON, or any other free email
address not attached to a school account.

® o

Password Confirm

i ) One account. All of Google
Use 8 or more characters with a mix of letters, numbers &

Use the two handouts below for yourself or | woring foryou
. |:| Show passwor
students - its easy peasy! e

Create a Google Account Online Tutorial
bit.ly/CreateGoo

Create a Hybrid Google Account Online Tutorial
bit.ly/CreateGooHybrid

MAIN
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https://docs.google.com/presentation/d/1VS9hqHXvJ5kSjCT8FBAXkZwBwLm9T_fOi_PCe6EYpGU/preview
https://bit.ly/CreateGooHybrid

ACCOUNT SECURITY

Accounts.google.com

New security checkup and recommendations

TIPS:

e Add 2FA (two factor authentication - just do
it!)
e NEVER save passwords in any browser!



https://accounts.google.com/

APPLIED DIGITAL SKILLS

Learn and teach digital literacy using Applied Digital Skills.

Lessons include lesson plans and rubrics for teachers.
All lessons are video-based.

ApSki can be “connected” with Google Classroom or linked using any
LMS.

Skills transfer to other platforms!

Lessons are available in Spanish - including videos!



https://applieddigitalskills.withgoogle.com/s/en/home

CLASSROOM

Allows teachers to schedule the

same assignment to different
classes at different times (aka
Publish date) with different due
dates.

Learn more

Schedule to multiple classes

Q DEMO CONEJO (this class)
Publish date (required)

Publish date (required)

e CLASS DEMO

Publish date (required)

v

v

Due date

No due date

No due date

Schedule across multiple classes

You can now define due dates, publish dates, and topics for classwork and
announcements across multiple classes. Learn more

Close

No topic v

No topic v

Cancel



https://workspaceupdates.googleblog.com/2022/03/schedule-posts-across-multiple-classes-in-google-classroom.html

DRAW

Create better images using Google Draw.

1. Create a new drawing (drawings.google.com)

2. Make the canvas LARGE using the hashmarks at lower left corner.

3. Paste a screen-grab onto the canvas - make sure the grab is as big as it
can be naturally.
a. Resize the canvas if needed - not the grab.

4. Edit as needed.

5. Download as PNG.

TIP

Draw over the image to make the text clearer readable. This also allows you
to make areas different colors or sizes to draw attention

§ A @, LUy . o W

Mute Stop Video Participants C hat Record Q&A




TOPIC
OFFLINE ACCESS on DOCS, SLIDES, SHEETS

Save is seen as Cloud with checkmark
(CTRL + S still does nothing but make
you feel better).

AND

Offline can now be enabled while a file
is open by selecting the Cloud (don't
do it unless you really need it!)

* B &
~ B -

(@ Allchanges saved to Drive

A This document is not ready for offline use

If you lose an internet connection, you can't edit this
document. To access your documents without an
internet connection, turn on offline.

Turn on



SEARCH

Evaluate Search results
Using Chrome web browser:

1. Open Google Search
2. Type a search criteria

3. Select the 3 vertical dots next to a web address( aka: more or skinny

snowman

4. An About this result card appears that gives information related to the site

including “More about this site”

{=
0

Go gle search 1 X

Q All [ Books = News [») Videos ) Images : More Tools

About 4,430,000,000 results (0.64 seconds)

https://www.google.com > search » howsearchworks

Discover How Google Search Works

Wondering how Google Search works? Learn how Google looks through and organizes all the
information on the internet to give you the most useful and relevant ...

Search - Algorithm - Crawl and index your site - How Search Works

https://www.google.com > imghp

Images - Google
Google Images. The most comprehensive image search on the web.

https://search.google.com » search-console » about
Google Search Console

Search Console tools and reports help you measure your site's Search traffic and performance,
fix issues, and make your site shine in Google Search results.

E Top stories

T The Verge N e
Google now lets you search ‘i Google now lets you search
for thinas voul can't describe bv comhinina imanes and }

SafeSearch on

Google Search
Website

” Search ‘

Google

Google Search, is a search engine provided by Google.
Handling more than 3.5 billion searches per day, it has
a 92% share of the global search engine market. It is
also the most-visited website in the world. The order
of search results returned by Google is based, in part,
on a priority rank system called "PageRank". Wikipedia

Date launched: 1998
Written in: Python, C, C++




SHARE INFO with YOURSELF!

When using Google Workspace for
Education, a CLUB account may be
precluded from doing things (get
add-ons, manage extensions, open
files, etc.)

TIP

Have a PUB account available to do
the voodoo you want to do!

e Share Edit rights with yourself (add
Pub account to Club share).

e Share personal calendar with Club. @

MAIN
TOC




Preview or Copy - choose wisely

This handout will be updated.

You can preview and always have the most updated

version - no Google account needed.

OR

You can copy and the slides are stuck in time. You wiill

need a Google account in order to make a copy.

PREVIEW: https://bit.ly/GooSlam22 - view any time it

will be updated.

MAIN
TOC

Copies will be allowed by sending a request to mholt@scoe.net

Creative Commons License

Attribution (BY): Give credit as “Melinda Holt, Google for Education
Certified Trainer”

NonCommercial (NC): You may copy, distribute, display, perform, and
use this work for any purpose other than commercially unless
permission is given.

Share Alike (SA): You may copy, distribute, display, perform, and modify
this work, as long as you distribute any modified work on the same
terms.

9

HOO

BY NC SA


https://bit.ly/GooSlam22

Need more info? ASK!

Ask and you shall be answered!
Send a message with “how do
you...” or “what about...” details and
I'll get back to you within 3 business
days (more or less.)

mholt@scoe.net



